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DTrio Version 6.0.2882.0 (February 17th, 2025) 

This is a maintenance release of DTrio. 

There are no changes to DTrio – this release is for suite versioning purposes only.  

DTrio Version 6.0.2880.0 (January 2nd, 2025) 

This release of DTrio is a re-release of version 6.0.2873.0 with minor template tweaks. 

DTrio Version 6.0.2873.0 (December 6th, 2024) 

This release of DTrio is a recommended upgrade for all users. We have added a workflow step to 

encourage audit and reviews of decision quality, cleaned up the inbuilt templates and fixed several 

bugs and minor issues. We have also added an additional wide screen capture mode. 

New Post Audit Form 

A new workflow step has been added to DTrio. It is a post audit workflow step that is used to assess 

the value of the decision quality exercise. It can be added to existing frames like any other workflow 

step. The inbuilt templates include the post audit step by default. 

The post audit step is best used in conjunction with the Decision Quality Assessment workflow step. 

DTrio Templates 

The included templates have been reviewed and cleaned up. The full framing templates have had a 

Decision Quality Assessment and a Post Audit step added to increase visibility and use of these 

tools. 

We added pre-populated tables for four scenarios in two different ways to the Scenario Planning 

template to reduce the effort in starting a scenario planning process. 

An Extended Framing template was added. This template contains a variety of tools that are used 

some of the time. This template contains more tools than are typically needed with the idea of 

deleting workflow steps, rather than adding them over time. 

Screen Capturing 

We have added 16:9 aspect ratio screen capturing and changed the labeling to make this clearly 

distinguishable from the already present 16:10 aspect ratio capture. 
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Other Minor Changes and Bug Fixes 

The Qualitative Assessment row title is defaulted to “Options” now. It can be edited by double-

clicking on it. 

The “Problem Statement” caption did not always correctly reflect the corresponding vocabulary 

setting from the Options menu. 

The Problem Definition export did not correctly use UTF-8 leading to special characters such as 

Spanish, French, or German letters with diacritics (e.g., ö, ň, ń, ù, ü, û, β). 

The Uncertainty Table could crash under rare circumstances when using the inbuilt screen capture 

tool. 

The Uncertainty Table screen captures sometimes cut off decisions that were part of the table. 

The Decision and Risk Timeline tab order has been improved to honor the visual order of rows and 

objects after moving objects during edit operations.  
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DTrio Version 5.1.2813.0 (June 26th, 2023) 

This is a maintenance release of DTrio.  

We improved the contrast of group names with light colors on the Strategy Table, Compare and 

Contrast Table as well as the Qualitative Assessment, both on-screen and print variants. 

We made small improvements to the Value of Information framing template’s pre-built Decision and 

Risk Timelines. 

DTrio Version 5.1.2806.0 (June 8th, 2023) 

This is a maintenance release of DTrio.  

Decision and Risk Timeline spacer shapes are now rendered invisibly in screen captures (i.e., just a 

horizontal gap). 

DTrio Version 5.1.2774.0 (December 9th, 2022) 

This is a maintenance release of DTrio. 

There are no changes to DTrio – this release is for suite versioning purposes only.  
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DTrio Version 5.1.2770.0 (October 10th, 2022) 

This is a maintenance release of DTrio. 

.Net Version 

TreeTop, DTrio and Owl are now built against .Net 4.8 (was 4.6 before); v4.6 is no longer supported 

by Microsoft and will no longer receive security updates. If you are using operating systems older 

than Windows 10, you may need to manually install the .Net framework 4.8 (or newer). 

Authenticode Signing and Strong Naming  

All assemblies (the various dll/exe files that make our applications) are now “strongly named”. This 

adds tamper-protection to the binaries, thus eliminating the possibility of someone taking our code, 

decompiling it, adding malicious code to it, recompiling it and distributing it.  

All dll/exe files as well as the installers are also Authenticode signed in addition to strongly named. 

This verifies the origin of the files and reduces or removes the security warnings that are displayed 

during installation. 

Issues Explorer 

The Issues Explorer now divides Focus Decisions by type (Future Impact, Information, “Blank”) only if 

the corresponding categorization column is shown in the Issues Table. This is identical to the logic 

used to enable/disable the Split Focus Decisions button on the Documents ribbon tab for the Decision 

Hierarchy. Otherwise, all Focus Decisions go into a single Focus Decisions category. 

New Application Options 

We added naming conventions for the Decision Quality Assessment to the Options. We also added 

Reset buttons to each naming conventions section in the application options. 

Strategy Table 

Screen captures now highlight strategy names and fixed columns (objective, rationale, etc.) if a 

strategy is selected. 

Bug Fixes 

The Issue List “Focus Decisions” naming convention did not load correctly from the registry after 

closing/re-opening DTrio 
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DTrio Version 5.0.2709.0 (January 17th, 2022) 

This is a maintenance release of DTrio. DTrio benefits from usability improvements to shared 

Decision Frameworks libraries, as well as DTrio specific changes. 

.Net Version 

DTrio – as well as TreeTop and OWL – are built on .Net 4.6 in this release. If you are using operating 

systems older than Windows 10, you may need to manually install the .Net framework 4.6 (or 

newer). 

Application Shell 

We have improved the ribbon backstage (“the File menu”) by adding icons, introducing a new Home 

tab and updating the New and Open tabs. 

In addition, we have also made usability improvements to the workflow bar, to make it easier to re-

order project entries by greatly increasing the mouse-sensitive portion of each workflow step. 

Qualitative Assessments 

We have improved legend spacing and font sizing. 
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DTrio Version 4.5.2628.0 (August 28th, 2020) 

This is a maintenance release of DTrio, fixing a number of small issues that has been reported by 

end users of the product. 

In addition, we have added a few minor usability improvements to the Influence Diagram workflow 

step that were cut in the last release, due to time constraints. 

Influence Diagram Usability 

We have increased the size of the dock points for the connectors in the Influence Diagram to make 

them easier to select when initiating addition of an influence arc. 

We reviewed and touched up the mouse cursors; the “Connector Add” mouse cursor was replaced 

entirely. 

Bug Fixes 

Qualitative Assessment 

DTrio could crash if a column was first moved and then the weight field was selected. This happened 

if the selection of the column was interpreted as a drag operation (mouse movement with pressed 

left mouse button). 

Star Ratings did not display correctly when using screen capturing. 

Strategy Table 

There was a crash report on Strategy Table font sizing – the data was inconclusive. We added code 

to avoid any crashes in this area of the code and revert to standard sizing under error conditions. 

The initial help prompt could obscure the Add Alternative button(s), if columns with multiple 

alternatives were added to the Strategy Table prior to adding any rows. 

Issue Table 

There was a crash report due to spell checking on the issue table. This could happen if a user right-

clicked on a word with a spell-check error before the spell check was concluded for the entire page. 
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DTrio Version 4.5.2610.0 (April 15th, 2020) 

This is a feature release of DTrio, introducing a new Qualitative Assessment workflow step and a 

host of improvements to all aspects of DTrio. 

General User Interface Changes and High DPI Support  

We reviewed all aspects of the DTrio user interface to fully support high dpi displays. Most 

prominently on the ribbon, we have replaced or improved the artwork throughout the application to 

look great on high dpi devices, such as 4k screens. There are only very few instances remaining in 

the application of artwork that require pixel-based scaling. 

As part of the user interface review, we have retired the vivid theme in all three color theme 

variants, as it was significantly weaker from a user interface design perspective than the neutral or 

light variants. 

The ribbon menus were tweaked in some instances and tooltip text has been reviewed in its entirety 

to ensure consistency throughout the application. 

Application Performance 

We improved various aspects of application performance for this release. In particular, systems with 

lower end graphics cards or slower processors should benefit from these changes. 

We targeted the Issues Explorer sidebar that is shared by most workflow steps, the Issues List, the 

Decision and Risk Timeline and the Strategy Table workflow steps. 

Mouse Issues in DTrio 

We have had some reports of mouse issues in DTrio. Upon investigation, we found that the mouse 

code was susceptible to lack of precision by the user (often introduced by using a touchpad), as well 

as unanticipated user actions (such as a drag operation interrupted by a right-click). We have 

reviewed and changed all mouse code in DTrio to fix these issues. 

Project Governance 

• New export features accessible via the ribbon 

• Added the ability to customize the default heading names under File → Options → Project 

Governance 

• Various small UI improvements 
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Problem Definition 

• New In-Scope and Out of Scope sections added 

• Spell checking added 

• New export features accessible via the ribbon 

• Added the ability to customize the default heading names under File → Options → Problem 

Definition 

• Various small UI improvements 

Issues List 

• Replaced the side bar controls for column display, custom column management and issue 

group management 

o Column width is now changed by drag-drop resizing 

o Column order is now changed by drag-drop re-ordering 

o Column visibility is now a right-click function 

o Column editing (caption for in-built columns, properties for custom columns) is 

accessible either via right-click or double-clicking 

o Create, edit, re-order and delete groups via a dialog that is accessible from the 

ribbon 

• An issues taxonomy (a.k.a. Issue Categorization Flow Chart) help screen has been added to 

the issues list 

• Performance improvements 

o Issues list performance is much better in many common usage scenarios. To achieve 

this, spell check initialization has been moved to an application idle-time task. Users 

may notice that it takes a few seconds for spell checking to “start working” on slower 

systems. 

• Various small UI improvements 

Uncertainty Table 

• Various small UI improvements 

Strategy Table 

• Significant performance improvements 

• Various small UI improvements 

• Strategies are now first-class objects in the data model and can be drag-added from the 

explorer sidebar, if already defined in another Strategy Table or Qualitative Assessment 
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Compare and Contrast Table 

• Re-worked the screen layout to be significantly tighter 

Influence Diagram 

• Mouse logic has been rewritten to greatly enhance usability and stability 

o Shapes can now be dragged by starting the drag operation anywhere on the shape 

o New mouse icons were added better indicate drag operations versus line operations 

o Double-click on a shape to edit text 

• Various small UI improvements 

• Performance improvements 

Decision and Risk Timeline 

• Decision and risk timeline rows can be duplicated to greatly speed-up the process of creating 

similar timelines 

• Significantly improved the user interface: 

o Added three display modes to allow the user to size timelines according to personal 

preferences 

o Made the notes section optional (show/hide via the ribbon) 

o Added a common caption bar similar to TreeTop’s level header functionality 

(show/hide via the ribbon) 

o Augmented right-click coloring of shapes  

o Added per-shape font-sizing and bold/italic options to the ribbon 

• A DTrio document can now have multiple decision and risk timeline workflow steps 

Qualitative Assessment 

Added a completely new Qualitative Assessment tool to DTrio. The workflow step can be used to 

qualitatively rate different strategies against each other (drag-in strategies previously defined in 

strategy tables), or to rate other items against each other. 

Each column (metrics) can be tailored in various regards 

• multiple rating types are available (such as icons, stars, colors, words) 

• each rating type can be tailored in its granularity 

• column weight can be changed, if a computation of row total’s is desirable 
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Decision Quality Assessment 

• Add a Notes section for user input for each milestone 

• Various small UI improvements 
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DTrio Version 4.1.1898.0 

This is a feature release of DTrio, introducing a new workflow step and significantly improving the 

Uncertainty Table, alongside other minor new features. 

Decision Quality Assessment 

We have added a decision quality assessment workflow step to DTrio. The workflow step can be 

added to any workflow. It consists of one or multiple meetings / milestones, at which decision 

quality is qualitatively assessed by rating each of the six dimensions of decision quality as proposed 

by the Society of Decision Professionals. 

 

We decided to keep the assessment “bare bones” for this release and are asking for customer 

feedback, as this has been a much-requested feature. 

Uncertainty Table 

The uncertainty table has been re-worked in a number of ways: 

◼ Frames can now have multiple uncertainty tables for complex Value of Information 

problems. 

◼ We have improved the visuals – both to be cleaner, and to fit more shapes onto a single 

screen. 

◼ The font sizing can now be changed. 
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◼ Tactical decisions can now be added without forcing a promotion to focus. 

 

 

Find and Filter Issues 

The Issues Explorer has a new search feature that will filter the issues to issues containing the search 

term. 
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Drop-In Problem Statement 

When facilitating, it sometimes becomes necessary to remind the team of the problem statement. 

We have added an optional drop-in problem statement that can be activated in any workflow step.  

 

Other Changes and Bug Fixes 

We have fixed all reported bugs and made a few changes in the application shell to better support 

high resolution environments, such as 4k displays. 

Logging has been added to DTrio to aid in trouble-shooting, when necessary. 

Corporate Licensing and Telemetry 

This release features application support for corporate licensing. In scripted environments 

(application deployed by IT) it is now possible to inject a corporate user license as part of the 

installation. This removes the need to obtain a license code from Decision Frameworks for 

application end-users. This feature requires registry keys to be added as part of the scripted 

installation – please contact us for more details. 

In addition to corporate licensing, we have also added application telemetry. Application telemetry 

allows us to gauge feature usage to aid direct our software development efforts. In addition, in 

corporate licensing environments, application telemetry is used to verify total user counts. 

Known Problems 

Under Windows 7/8, a small number of icons/glyphs may not be drawn correctly and replaced with a 

small rectangle. This depends on the update status of the installed system fonts. 
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DTrio Version 4.0.1746.0 

This is a priority maintenance release. We suggest that all users – in particular those running version 

1715 – update as soon as possible. 

Performance 

Version 4.0.1715.0 introduced a performance issue due to the component changes. The Issue Table 

could suffer from severe keyboard latency due to a problem in a third-party component. We’ve 

dropped the third-party component from the Issue Table application entirely and replaced it with an 

equivalent. 

We also improved performance of the Issue Table in various other scenarios for larger frames. 

Minor Changes 

We improved various minor graphical displays. 

DTrio Version 4.0.1715.0 

This release is a maintenance release that fixes various reported bugs. 

We updated UI components in use (the ribbon in particular) to fix bugs that were reported by clients 

that had been fixed by the third-party component vendor. 

DTrio Version 4.0.1689.0 

This release is a maintenance release that fixes two reported bugs. 

Issues List 

Custom columns that were set to hidden did not correctly remove their input fields (drop downs / 

checkboxes). These input fields appeared in adjacent columns. 

Decision Hierarchy 

There was a rendering bug that led to repeated and incorrectly indented headings being displayed 

when showing decisions from multiple groups and enabling Split Decisions from the ribbon. 
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DTrio Version 4.0.1666.0 

This release is a maintenance update for DTrio users. We encourage all users to upgrade at their 

earliest convenience. 

User Interface Enhancements 

The main feature of this version of DTrio is a re-designed ribbon menu. The new ribbon menu 

collapses all document specific tasks into a single place (Issues List commands, Strategy table 

commands, Influence Diagram commands, etc.) and the contents of that tab change according to 

context. 

The change in the ribbon appearance simplifies the perceived complexity of the product, as we 

found that users perceived DTrio as being unnecessarily complex. As an additional benefit, the 

required number of mouse clicks has been significantly reduced, letting users concentrate more on 

the frame and much less on the software. 

  

We have also made small improvements throughout the product, such as adding hover indicators to 

the strategies in the Strategy table to better indicate that users “need to click here” to select a 

strategy and begin assigning markers. 

Performance Improvements 

Most operations involving Fixed Columns in Strategy tables have been rewritten for much better 

performance. Those users working extensively with fixed columns should see a drastic change – wait 

times for most operations are almost non-existent now. Re-ordering of fixed columns has not been 

optimized for this release. 
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Minor Changes 

When the short name has not been entered for a shape on the influence diagram, the description 

text is shown instead – the description text is now shown on multiple lines to accommodate the 

wordier nature of descriptions. 

Bug Fixes 

Influence diagram mouse actions were overly sensitive on non-96 dpi setups, resulting in an inability 

to move shapes etc. 

On Strategy tables, decision column headers did not show correctly on screen captures when no 

short name had been entered. Now the description is shown on screen captures in these cases; on 

screen captures, the text is not italicized. 

On Influence diagrams, shape text did not show correctly on screen captures when no short name 

had been entered. Now the description is shown on screen captures in these cases; on screen 

captures, the text is not italicized. 

Mouse cursor indicators to re-order various parts of the Strategy table are more consistent. 

On Decision and Risk Timelines, the Issues Explorer did not synchronize immediately when issues 

were added to the frame from within the DRT. 

Fixed a spurious crash when copy/pasting issues from CSV based source formats (null content – 

such as an empty CSV table on the system clipboard could cause a crash). 

Further Bug Fixes 

All automated crash reports have been addressed. 
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DTrio Version 4.0.1560.0 

This release is a maintenance update for DTrio users. We encourage all users to upgrade at their 

earliest convenience. 

Bug Fixes 

Strategy Table 

The Strategy Table font sizing available from the ribbon did not work. This has been fixed. 

Crashes due to Windows Shared Resource Locks  

DTrio uses a number of Windows shared resources, such as the Windows clipboard. These shared 

resources allow users to, for example, copy and paste text from Word into DTrio, copy/paste within 

DTrio, or generate images in DTrio and paste them into Microsoft PowerPoint. 

When these resources locked up, for example due to very high system load or because another 

software product blocked access to these resources, DTrio crashed. 

We have identified and fixed approx. 150 bugs and crashes associated with these resource locks. 

Minor UI Changes 

DTrio benefited from minor tweaks in our shared user interface library. These tweaks were added 

for TreeTop and compiled into DTrio for this release. 

Performance Improvements 

Further simplification of the DTrio graphics stack have increased overall application performance 

slightly, as well as decreased application start-up time. 

File Format 

This release of DTrio has no file format changes to the previous release. Files can be interchanged 

between 4.0.1560.0 and 4.0.1535.0. 
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DTRIO version 4.0.1535.0 (DTrio 2017) 

This release marks a major milestone in DTrio development. 

We have taken the feedback from our DTrio 2014 users and incorporated it into our next major 

DTrio release. Virtually every aspect of DTrio has been changed for the 2017 release to simplify and 

streamline the user experience. 

We encourage all users to upgrade to DTrio 2017 as soon as possible.  

Some of the highlights of this release are: 

1. Adoption of a Windows 10 / Office 2017 look. In addition to a new application shell design, 

we have changed the fonts throughout the application for better on-screen readability and 

added more font sizing options to DTrio. DTrio now utilizes a triple-pane screen layout with 

the current Workflow step in the center, the Workflow on the left and Workflow step options 

on the right. 

2. We have completely changed the way in which DTrio Workflows are customized and 

ordered. Workflows can now be changed seamlessly via simple drag/drop operations whilst 

framing. Adding new steps to the workflow is one mouse-click away. The workflow 

customization dialog of DTrio 2014 has been retired. 

3. In addition to the standard Workflows that ship with DTrio 2017 “out of the box”, end users 

and companies can now add their own templated Workflows to the “File -> New” ribbon 

menu. 

4. A much cleaner Issues Table with user-customizable column order and widths and visibility. 

5. Improvements to the Strategy Table, as well as new layout options to better facilitate non-

standard uses of the Strategy Table. 

6. Completely re-designed Compare and Contrast Tables based on customer feedback. 

7. Improved all aspects of DTrio to facilitate better screen sharing, projection and screen 

capturing. 

8. Many small features based on client requests, such as spell checking for the Issues list and 

customizable automatic omission settings for issues added in later parts of the Frame. 

In addition to the new and re-designed features, we have also fixed all known bugs and improved 

application performance significantly. 

File Format 

Please note that users of DTrio 2014 will not be able to open files created in DTrio 2017. DTrio 2017 

imports DTrio 2014 frames and upgrades them to the new file format automatically. 
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Contact Information 

If you have any questions or experience any problems, please contact 

support@decisionframeworks.com or call +1 713-647-9736 during normal business hours which are 

9:00 a.m. – 5:00 p.m. CST. 
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